
Meet the Microsoft Mastering Series
Mastering Web Site Development Using Visual InterDev is one in a series of CD-ROM-based training programs. 
Other Mastering Series titles currently available are:

® Mastering Microsoft Exchange Development
® Mastering Internet Development with Microsoft ActiveX Technologies
® Mastering Microsoft Office 97 Development
® Mastering Microsoft Visual Basic 5
® Mastering MFC Development Using Visual C++ 5
® Mastering Microsoft Visual J++

The Microsoft Mastering Series titles are content-rich, self-paced, interactive CD-ROM-based learning tools 
designed to help you quickly master Microsoft development tools. The courses combine high-level technical 
content with an intuitive learning methodology, so you can learn in the way that best suits your schedule and 
study habits.

All Mastering titles include interactive lessons, narrated demonstrations, hands-on labs, sample code, and a 
library of reference material to supplement courses and exercises. You can navigate directly to the Course 
material or library resources that you want by using a flexible browsing and searching system.

Most of the Mastering Series courses are Microsoft Official Curriculum, and can be used to gain the necessary 
skills for Microsoft Certification. Microsoft Mastering Series products are not introductory courses on 
programming. It is assumed that you have experience using Microsoft development tools to create solutions for 
Microsoft Windows.
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Take the Tour
The best way to familiarize yourself with Mastering Web Site Development is to take a short multimedia tour of 
the title. The Tour is accessible from the Help menu and the Welcome screen.



System Requirements
To run Mastering Web Site Development Using Visual InterDev, you need:

® A personal computer with a 486DX or higher processor running Microsoft Windows 95 or Microsoft Windows 
NT Workstation version 4.0

® 16 megabytes (MB) of memory for Windows 95; 24 MB of RAM for Windows NT Workstation
® 10 MB available hard disk space
® CD-ROM drive
® VGA or higher resolution monitor; Super VGA, 256 colors recommended
® Microsoft Mouse or compatible pointing device
® Audio board with headphones or speakers recommended
® Internet connection through a modem or proxy server recommended

Additional software requirements to complete labs:

® Microsoft Internet Information Server; Microsoft Peer Web Services for Windows NT Workstation; or Microsoft
Personal Web Server for Windows 95 (Windows NT Server with Internet Information Server 3.0 
recommended)

® Microsoft Internet Explorer 3.0 or later
® Visual InterDev
® Microsoft Transaction Server required for Lab 9 (Using Microsoft Transaction Server)
® Microsoft SQL Server version 6.5 required for Lab 9 (Using Microsoft Transaction Server)
® Visual Basic version 5.0 required for Lab 8 (Creating ActiveX Server Components).



Requires Windows NT.



Using the Navigation Pane
The Navigation pane occupies the left pane of the Viewer window, and is used to navigate through the content of
the title. On the Contents menu at the top of the navigation area, you can choose a component of the Course or 
a section of the Library to be displayed in the Topic pane at the left of the Viewer window.

Use the Contents buttons to view the Contents menu or to find information, as follows.

Contents. Displays the Course components or Library
sections.

Index. Displays index entries related to particular 
topics in the Course and Library.

Find. Displays the Find pane, where you can search 
for a word or topic.

The Navigation pane is separated from the Topic pane by a split bar that you can drag to change the size of both
panes.
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The Course components are:

® Course. Displays the chapters for the Course, and includes the following components.

® Labs. Include exercises that provide experience using the skills presented in the chapters.
® Multimedia. Includes audio and video animations and demonstrations of the concepts and techniques 

covered in the Course.
® Sample Code. Provides code samples to illustrate the material covered in the chapters and labs.
® Self-Check Questions. Test your understanding of the material covered in each chapter by answering the 

Self-Check questions.



Viewing Content in the Topic Pane
When you select a topic in the navigation area, the text and associated media displays in the Topic pane. You 
can view the following elements in the Topic pane.

® Course or Library selections
® A topic selected from the Notebook
® A topic selected from the History window
® Index entries
® Search results from using the Find feature

You can use the navigation buttons at the bottom of the Topic pane to move forward and back through the 
Course contents, or to jump to information that is related to the currently displayed topic.

You can select text displayed in the Topic pane to copy to the Clipboard. You can also print the topic.

To change the size of both panes, drag the split bar between the panes.
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Displaying Multimedia and Additional 
Information
Throughout Mastering Web Site Development, you will find multimedia icons that you can click to:

® View additional information, such as narrated demonstrations and animations, graphics, sample code, and 
tips.

® Execute programs stored on the CD-ROM, including Setup for various Microsoft tools.
® Launch online Help files.
® Launch Internet Explorer and jump to a specific address.

Here are icons that you will see throughout the Course. To view a description of each icon, click the icon.

Animations. An animated introduction describes what
you can expect to learn in the chapter. Additional 
animations in the Course illustrate technical concepts.
Demonstrations. Help you learn by watching and 
listening, as a developer takes you through the steps 
of a procedure.
Executables. Launch executable programs stored on 
the Mastering Web Site Development CD-ROM.
Expert Points of View. Provide the technical 
expertise of an experienced developer.
Help. Launches online Help files.

Illustrations. Display technical illustrations and 
diagrams.
Internet. Launches Internet Explorer and jumps to a 
specific Internet address.
Sample Code. Displays a pop-up window of sample 
code.
Self-Check Questions. Provide several questions 
and one answer at the end of each chapter.
Tips. Provide helpful information.
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Choosing a Display Mode
You can view the Contents, Index, or Find features by clicking one of the buttons at the top of the Navigation 
pane on the left, while displaying the associated information in the Topic pane on the right. Or, you can hide the 
Navigation pane and view only the Topic pane.

u To display both panes of the window, do one of the following
® On the View menu, click Navigation & Topic.
® Press CTRL+A.
® Point to the left pane, right-click, and then click Navigation & Topic on the shortcut menu.
® Click the Navigation & Topic button on the toolbar.

u To display the Topic pane only, do one of the following
® On the View menu, click Topic Only.
® Press CTRL+O.
® Point to the left pane, right-click, and click Topic Only on the shortcut menu.
® Click the Topic Only button on the toolbar.
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Introducing the Course
In this Course, you will learn how to create enterprise-level Web sites that use ActiveX components on both the 
client and the server.

The Course includes an assortment of labs that give you hands-on experience using the skills learned in the 
chapters. Each lab consists of one or more exercises that focus on the information contained in the associated 
chapter. At any time, you can review solutions to the lab. The Course also includes narrated demonstrations and 
animations, sample code, and tips. You can test your understanding of the material by answering the self-check 
questions.

The Library contains extensive technical references and resources, including articles and white papers, 
Knowledge Base articles, books, pointers to relevant World Wide Web sites, and useful tools that you can install 
from the CD-ROM.

Taking the Tour is the best way to learn about the contents of the Course and how to navigate. The Tour is 
accessible from the Welcome screen and from the Help menu.
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An Overview of Course Content
Click a button below for a description of each chapter in the Course:

Ch 1 Planning a Web Site
Ch 2 Developing a Web Project
Ch 3 Using Visual InterDev Data Tools
Ch 4 Using Objects on Web Pages
Ch 5 Adding Client-Side Script
Ch 6 Using Active Server Pages
Ch 7 Creating Database-Aware Web Pages
Ch 8 Creating ActiveX Server Components
Ch 9 Using Microsoft Transaction Server
Ch 10 Controlling Access to a Web Site

You can take the Course in any order that you choose start at the beginning, jump into the middle, or read only 
those topics that interest you.
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Chapter 1 introduces you to the technology used in the course. You will learn how each member of a Web 
development team contributes to the process of planning and creating a Web site.



Chapter 2 teaches you how to use Microsoft Visual InterDev to create and manage a Web site. You will also 
learn how to create HTML pages and Active Server Pages by using the FrontPage Editor and the Visual 
InterDev Source Editor.



Chapter 3 describes how to connect to and access a database from a Web page by working with the Data Form
Wizard and the design-time data range controls in Visual InterDev. You will also learn how to use Visual InterDev
DataView and the Query Designer to create SQL queries for a database.



Chapter 4 demonstrates how to create interactive Web pages by adding ActiveX controls and Java applets to a 
Web page. You will also learn how Microsoft Internet Explorer downloads and runs these objects to exchange 
data with a Web server.



Chapter 5 teaches you how to add client-side script to a Web page You will learn how to use client-side script to 
create active Web pages that respond to user input, validate data in a form, and to manipulate objects, such as 
ActiveX controls and Java applets.



Chapter 6 demonstrates how to use Active Server Pages in your Web application. You will learn how to read 
information from an HTTP request and customize the HTTP response, store information about a user, and 
determine the capabilities of a client's browser.



Chapter 7 describes how to create Web pages that can retrieve and update information in a database. You will 
learn how to use ActiveX Data Objects (ADO) and the Advanced Data Connector (ADC) to connect to data 
sources and display data.



Chapter 8 discusses how to create business services that run on a Web server. You will learn how to use Visual 
Basic 5.0 to build ActiveX server components that contain business rules, and to call these components from a 
page on your Web site.



Chapter 9 introduces Microsoft Transaction Server (MTS), an application that provides transaction and resource
management for ActiveX server components. You will also learn how to create Microsoft Transaction Server 
components, which are ActiveX server components that work within the MTS application environment.



Chapter 10 demonstrates how to use Windows NT and Internet Information Server (IIS) to control the access to 
your Web site. You will learn how to control which files a user can access, and which operations the user can 
perform on your Web server. You will also learn how to use digital certificates to identify users.



Course Components
Mastering Web Site Development consists of components that can be accessed from within the Course or 
Library content, or directly from the menu at the top of the Navigation pane. The Course components include:

® Course
® Labs
® Multimedia
® Sample Code
® Self-Check Questions

Within the Course chapters, you'll also find:

® Executables
® Help Files
® Graphics
® Internet Jumps
® Tips

Related Topics



Multimedia demonstrations, animations, and expert points of view illustrate and help you master programming 
concepts and techniques. You can jump to a list of demonstrations, animations, and expert points of view by 
clicking Multimedia on the Contents menu. To launch a demonstration, animation, or expert point of view, click 
the one you want in the Navigation pane.

To launch a demonstration from within the Course, 
click a demonstration icon.
To launch an animation from within the Course, click
an animation icon.
To launch an expert point of view from within the 
Course, click an expert point of view icon.

Note    You can toggle the Closed Caption (CC) option on and off in the media viewer window to view the 
associated text of an animation, demonstration or expert point of view.

Each pop-up window has a slider control that enables you to play, pause, or jump to another location in the 
media file.



Executable files can be launched from within Mastering Web Site Development.

To launch an executable file, click an executable icon.

Follow the installation instructions specific to the program you have executed.



Help files can be launched from within Mastering Web Site Development.

To launch a Help file, click the Help icon.

Note    The Mastering Web Site Development Help file can be launched from the toolbar or from the Help menu.



Illustrations are provided to show important information described in the Course. You'll see three types of 
illustrations:

® Standard in-line graphics.
® In-line graphics with hot spots you can click to view additional information.
® Pop-up graphics. Click the Illustration icon within the Course to view an illustration.

You can print or copy an illustration to the Clipboard by using the toolbar or menu commands.



Launch Internet Explorer to jump to a specific site on the Internet.

To launch Internet Explorer and jump to a specified 
Web page, click the Internet Jump icon, and then 
click OK in the dialog box.

Note    The first time you launch Internet Explorer from Mastering Web Site Development, a dialog box is 
displayed to inform you that you are about to launch Internet Explorer. If you do not want this prompt to appear 
each time you launch Internet Explorer, you can turn off the message by clicking View this dialog when 
launching Internet Explorer 3.0 or greater in the dialog box.

You can browse the Web site you jumped to, or surf the Internet by entering other URLs in the Address text box, 
shown below:

To return to Mastering Web Site Development, minimize or close Internet Explorer.



Labs in each chapter illustrate programming concepts and techniques. You can jump to the lab exercises by 
clicking Labs on the Contents menu, or by clicking the lab you want within the Course. In the Course, labs and 
their solutions appear at the end of the chapter section with which they are associated.

Each lab has associated project, solution, and demonstration files. You can review the complete solution for 
each lab within the Course, or by clicking Multimedia on the Contents menu.



A list of Sample Code is available by clicking Sample Code on the Contents menu. To display sample code in 
the Topic pane, click the chapter or lab, and then click the code you want from the list in the Topic pane.

Or, you can view sample code by clicking a Sample 
Code icon within the chapters or labs in the Course.

The Sample Code window opens to the same size and location as when it was last closed. You can resize the 
window by dragging its borders.

You can copy sample code to the Clipboard. Or, you can print the sample code displayed in the window. To copy 
or print sample code, right-click in the Sample Code window, and then click Print or Copy.



Test your understanding of the Course material by answering the Self-Check questions. You can view a list of 
the Self-Check questions by clicking Self-Checks Questions on the Contents menu, or by clicking Self-Check 
Questions at the end of each chapter. The Self-Check questions provide several questions with one correct 
answer for each.

To view an answer to a self-check question, click the 
answer icon.

The answer window opens to the same size and location as when it was last closed. You can resize the window 
by dragging its borders.

You can copy or print an answer to the Clipboard. To print or copy an answer, right-click the Topic pane when a 
self-check question is displayed, and then click Print or Copy.

Note    You can also print the questions displayed in the Topic pane by clicking the Print button on the toolbar.



Tips are provided throughout the chapters.

To view a tip, click a tip icon within the Course.

The Tip window opens to the same size and location as when it was last closed. You can resize the window by 
dragging its borders.

You can select a portion of a tip to copy it to the Clipboard, or you can print or copy the entire tip. To print or copy
a tip, right-click the Tip window, and then click Print or Copy.



Put the Index to Work
You can use the Navigation pane to search the Index containing information from the Course and Library. 

u To search the Index, do one of the following
® On the View menu, click Index.
® Press CTRL+I.
® Point to the Navigation pane, right-click, and then click Index on the shortcut menu.
® Click the Index button at the top of the Navigation pane.

u To use the Index
1. Click the text box, and type the first few letters of the word that you want to find. 

The Index will scroll to the closest entry and list related topics in a list box at the bottom of the Navigation 
pane. 

2. Click an Index entry to display the associated topic in the Topic pane.
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Using Find to Refine Your Search
u To use Find to search for a word or phrase, do one of the following
® On the View menu, click Find.
® Press CTRL+F.
® Point to the Navigation pane, right-click, and then click Find on the shortcut menu.
® Click Find on the toolbar.

You can type a word or phrase, or select a previous search string from the drop-down list. To search for a 
phrase, enclose the phrase in quotation marks. You can also use Boolean operators to refine your search.
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Using Boolean Operators
Mastering Web Site Development supports the following Boolean operators in the Find tool.

Operator Description Example

* Matches any number 
of characters in a 
word.

valid* finds valid, 
validate, validation.

AND
+ (plus)
& (ampersand)

The logical AND ( + ) 
and the ampersand 
operators find topics 
that only contain all of 
the strings.

language AND logic 
finds topics that only 
contain both words.

OR
| (pipe)
, (comma)

The logical OR ( | ) 
and comma operators 
find topics that contain 
any of the listed 
strings.

language OR logic 
finds topics that 
contain either word.

NOT
- (minus)
~ (tilde)

The logical NOT ( - ) 
and tilde operator find 
only topics that do not 
contain the string.

language NOT logic 
finds topics that 
contain the word 
language, and do not 
contain the word logic.

NEAR The NEAR operator 
finds only those topics 
within eight words.

save NEAR print finds
those topics that only 
contain the two words 
within eight words from
each other.

You can combine multiple operators in a single search. The search string is evaluated from left to right. You can 
also enclose a phrase in quotation marks to search for that exact phrase, rather than the individual words within 
it. You can force the search string to be evaluated in a different order by enclosing portions of it in parentheses.

To run the search, press ENTER. When the results list appears, click a topic to view it in the Topic pane. The 
word or phrase for which you searched is highlighted in the displayed topic.



Viewing the Glossary
u To see glossary terms and definitions, do one of the following
® To display an associated glossary definition, click any word or phrase in the Course that is underlined, in 

magenta text.
® Click the Glossary button on the toolbar to open the Help file and search for a word or phrase.
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Revisiting Topics Using the History Window
To browse through a list of previously visited topics, open the History window by clicking History on the 
Navigate menu, or by pressing CTRL+H.

Click a topic in the History window to display it in the Topic pane. If the Contents are displayed in the Navigation 
pane, the title of the topic in the History window will be selected.

Note    You must use the mouse to select a topic in the History window. The keyboard is disabled in this window.

The History window stays on top of the Viewer window until you close it. The window opens in the same size 
and location as when it was last closed. You can move the window or drag its borders to suit your needs.



How to Use the Library
To display the Library, click the Contents button, and then click the Library option you want to view. The text of 
the Library item will appear in the Topic pane.
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What You Can Find in the Library
The Library contains a broad variety of reference material, such as:

Articles and White Papers

Knowledge Base

Sample Applications

Books

Resources

When viewing the Course topics in the Topic pane, you can jump quickly to related information in the Library by 
clicking the Related Information menu, or by clicking Related Information on the Navigate menu.

Note    The Related Information menu appears dimmed if there is no related information available in the Library
for that topic.
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The Articles and White Papers section contains many technical articles and white papers related to the Course
contents.



The Knowledge Base section includes numerous Knowledge Base articles relevant to Web site development 
and also provides a link to the Knowledge Base page on the Microsoft Web site.



The Sample Applications section of the Library contains sample applications relevant to Web site development.



In the Books section, you'll find a list of books of interest to Web site developers, published by Microsoft Press. 
This section also includes sample chapters from three Microsoft Press books.



Exploring the Resources Section
In the Resources section of the Library, you'll find the following:

® Microsoft Programs. Learn more about the programs available from Microsoft, including the Microsoft 
Certified Professional Program, the Microsoft Solution Provider Program, and the Microsoft Logo programs.

® Microsoft Technical Support. Provides information about online, CD-ROM-based, fax-based, and phone-
based support for Microsoft products. This section includes support phone numbers.

® Microsoft Technical Training and Education. Read about a variety of Microsoft Technical Education 
options, including face-to-face, online, and self-paced training.

® Lists and References. Provides a list of user groups and mailing lists of interest to a Web site developer.
® Publishers. Find out about book and magazine publishers of Web site development-related material.
® World Wide Web. Check out various Microsoft Web sites that provide information about developing custom 

solutions with the Developer Studio environment, Visual InterDev, and other Microsoft tools and technologies.
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Creating Notebook Entries
You can use the Notebook to mark topics of interest anywhere in the Course and make notes about these 
topics. You can return to these notes at any time during the current session or during future sessions.

u To open the Notebook, do one of the following
® On the Edit menu, click Notebook.
® Press CTRL+K.
® Point to the Navigation or Topic pane, right-click, and then click Notebook on the shortcut menu.
® Click Notebook on the toolbar.

For more information about using the Notebook, click on an item below:

Add or delete a Notebook entry

Add, edit, or delete your notes

Display a Notebook entry in the Topic pane

View notes for current topic

View Help in the Notebook

Printing Notes and Notebook entries



u To add a topic to the Notebook, click the topic in the Navigation pane, and then
® Click the Notebook button on the toolbar to open the Notebook window.

® Click the Add to Notebook button on the Notebook toolbar.

u To delete a Notebook entry, select it from the Notebook list, and then:
® Click the Delete button on the Notebook toolbar.



u To add new notes to the Notebook or edit existing notes 
® Add the topic to the Notebook, or select an existing Notebook entry, and then type your notes in the Topic 

pane.
® Click the Add to Notebook button to attach your notes to the existing Notebook entry.

u To paste text or graphics from the Topic pane into the Notebook window, copy the information to the 
Clipboard, and then do one of the following

® Press CTRL+V.
® Right-click the Notes pane in the Notebook window, and then click Paste on the shortcut menu.
® Click the Paste button on the toolbar.

Note    When you edit your notes, you can right-click to select the standard Windows editing commands, Undo, 
Cut, Copy, Paste, and Select All.



To display a topic from the Notebook window in the 
Topic pane, select the topic in the Notebook 
window, and then click the Go To Topic button, or 
double-click the topic.



To view the notes for the currently displayed topic, 
click the Notebook button on the toolbar.



You can view What's This? online Help for the toolbar buttons and windows in the Notebook. Point to the button
or window for which you want help, right-click, and then click What's This?.



Printing Notes and Notebook Entries
You can print all of the topics listed in your Notebook, print only the current Notebook entry, print all your notes 
for the current entry, or print all your notes for all topics.

u To print in the Notebook window, click the Print button and then click one of the following options
® Print current Notebook topic. Prints the selected Notebook entry.
® Print all Notebook topics. Prints all topics stored in your Notebook.

You can choose one or both of the following to print the Notebook topic(s) with or without your notes.

® Include Topic Text. Prints the selected entry or all Notebook entries.
® Include Notes. Prints notes that are associated with the selected entry, or all notes that you have added to 

the Notebook.

To print the option you want, click the Print button, or click Cancel to close the dialog box without printing.
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Printing Topics and Other Information
You can print the topic text displayed in the Topic pane. 

u To print, do one of the following
® On the File menu, click Print.
® Press CTRL+P.
® Right-click in the Navigation pane, and then click Print on the shortcut menu.
® Click the Print button on the toolbar.

When you click Print, a Windows Print dialog box appears. Select the options you want, and then click OK.

Related Topics



"What's This?"--Help About Toolbars, Menus,
and Windows
To find out what a screen element does, you can point to the element for which you want Help, right-click, and 
then click What's This?.



The Toolbar Buttons
Main Viewer Toolbar

Print. Click to print the entire topic displayed in the 
Topic pane.

Copy. Click to copy highlighted text or the entire 
topic displayed in the Topic pane. You can paste 
your selection into another application or into your 
Notebook. (Open the Notebook window, click the 
Topic pane, and then press CTRL+V.)

Navigation & Topic. Click to display the Navigation 
pane in the left pane while viewing the Topic pane in 
the right pane. To close the Navigation pane and 
display only the Topic pane, click Topic Only.

Topic Only. Click to close the Navigation pane and 
display the Topic pane only. To display both panes, 
click the Navigation & Topic button.

Notebook. Click to open the Notebook, where you 
can store a list of topics of particular interest, along 
with your notes.

Glossary. Click to view an extensive glossary of 
related terms and definitions.

Help. Click to get Help for Mastering Web Site 
Development.

Notebook Toolbar
Add to Notebook. Click to add the selected topic to 
your Notebook.

Delete. Click to delete the selected topic from your 
Notebook.

Print. Click to print topics or notes from your 
Notebook.

Paste. Click to paste the selected topic text or 
contents of the Clipboard into the Notebook window.

GoTo. Select a topic in the Notebook, and then click 
to display the topic text. You can also go to a 
specific topic by double-clicking the topic in the 
Notebook window.



The Menu Commands
Click a menu command to see a description of what it does.

File menu

Edit menu

Navigation menu

View menu

Help menu



When the standard Windows Print dialog box appears, enter or click your the options you want, and then click 
OK to print.

If you are printing from the Notebook window, select the options you want in the Print dialog box, and then click 
OK to print.
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Closes the application.



Copies the text or graphics you selected in the Topic pane or Notebook. To paste the selection into another 
application, open the application, and then click Paste on the Edit menu, or use the key combination for the 
application's Paste command (CTRL+<KEY>).

u To paste text or graphics from the Topic pane into the Notebook window, copy the information to the 
Clipboard, and then do one of the following

® Press CTRL+V.
® Right-click in the Notes pane of the Notebook window, and then click Paste on the shortcut menu.
® Click the Paste button.



Opens the Notebook, where you can mark topics of interest and make notes about these topics.



Moves to the next topic in the Navigation pane.



Moves to the previous topic in the Navigation pane.



Moves back through the topics you have viewed.



Displays a list of the topics you have viewed. To display a previously viewed topic click a topic in the History 
window.



Displays a list of topics related to the current topic. To display a related topic, click a topic from the list.

This is the same as clicking the Related Information menu at the bottom of the Topic pane.

Note If there is no related information for the topic in the Library, these options will appear dimmed.



Displays both the Navigation pane and Topic pane.



Displays the Topic pane only.



Displays the Contents in the Navigation pane.



Displays the Index in the Navigation pane.



Displays the Find window.



Displays the Magnify menu from which you can magnify or reduce text in the Topic pane or in any window 
(Sample Code, Tips, Closed Captions).

u To magnify or reduce text, select one of the following options
® 75% reduces all text to 75% of its normal size.
® 100% returns all text to its normal size.
® 150% magnifies all text to 150% of its normal size.
® 200% magnifies all text to 200% of its normal size.



Displays the text of video segments in a pop-up window. You can move and resize the window to view the video 
and closed caption simultaneously.

Note    The pop-up window will appear in the same location as it was when you last opened it.



Displays a dialog box when you launch Internet Explorer from within Mastering Web Site Development.



Opens this Help file.



Displays the Welcome screen, where you can take the Tour or view a video introduction of Mastering Web Site 
Development.



Launches the Tour for Mastering Web Site Development.



Displays a glossary of terms and definitions.



Connects to the Mastering Series Web page on the Microsoft Web site.



Displays the name, version, and copyright information for this product.



The Shortcut Menus
A shortcut menu is available from the Viewer window and most supplementary windows, including the right pane
of the Notebook window. The commands on a shortcut menu change depending on where you right-click the 
mouse. To display a shortcut menu, right-click in a window, and then click the menu command you want.

Click the following shortcut menus to display a brief description of each menu command.

Navigation and Topic Pane
These commands appear 
when you right-click in the 
Navigation or Topic pane in 
the main Viewer window.
A check mark on this menu 
indicates the currently active 
pane, or window and mode.
When you select Topic Only, 
you can restore the 
Navigation pane by clicking 
Navigation & Topic on the 
menu.

Notebook Window
The left pane of the Notebook
window displays these 
commands.

The right pane of the 
Notebook window displays 
these standard Windows 
editing commands.

History Window
These commands appear 
when you right-click the 
History window.



Supplementary Viewer
The active text or 
supplementary graphics 
viewers display these 
commands.

Note    A shortcut menu is not available in the Animation, Demonstration, and Expert Point of View windows.



Displays both the Navigation and Topic panes in the main Viewer window.



Displays only the Topic pane in the main Viewer window. You can restore the Navigation pane by clicking 
Navigation & Topic on the shortcut menu.



Displays the Contents in the Navigation pane.



Displays the Index in the Navigation pane.



Displays the Find window in the Navigation pane.



Opens the Notebook window.



Opens the History window.



Opens the Windows Print dialog box.



Copies the selected text, or the entire text or illustration displayed in the window, to the Clipboard.



Opens the Mastering Series Help file.



Moves back to the previously viewed topic.



Provides context-sensitive Help for the active screen element.



Adds the displayed topic to the Notebook, where you can also add notes.



Deletes the selected Notebook entry.



Deletes the selected text in the Notes pane of the Notebook window.



Goes to the selected Notebook topic and displays the text and associated media icons in the Topic pane.



Opens the Print dialog box. You can print a selected Notebook entry or all entries with or without your notes. You
can also print the notes associated with the selected Notebook entry, or print all of your notes. After selecting the
options you want and clicking Print, the Windows Print dialog box appears.



Pastes text from the Clipboard into the Notes window.



Clears the previous edit made in the Notes window.



Cuts the highlighted text from the Notes window and copies it to the Clipboard.



Selects all text in the Notes window.



Using Setup to Uninstall
u To uninstall Mastering Web Site Development from the Setup program
1. Run Setup from the CD-ROM.
2. Click Remove All.

Note    Do not remove any shared DLLs unless you are sure they are not being used by other applications.



Using the Control Panel to Uninstall
u To remove Mastering Web Site Development from your system by using the Control Panel, follow 

these steps
1. In the Control Panel, click Add/Remove Programs.
2. Select Mastering Web Site Development, and then click Add/Remove.
3. Click Remove All.

Note    Do not remove any shared DLLs unless you are sure they are not being used by other applications.



A context-sensitive Help topic is not available for this item. Right-click with the mouse to view What's This? 
Help.



Print. Click to print the entire topic displayed in the Topic pane.

Copy. Click to copy highlighted text or the entire topic in the Topic pane. You can paste the 
selection into another application or into your Notebook. Open the Notebook window, click the
right pane, and press CTRL+V.

Navigation & Topic. Click to display the Navigation pane on the left of the window or while 
viewing the Topic pane on the right. To close the Navigation pane and display only the Topic 
pane, click Topic Only.

Topic Only. Click to close the Navigation pane and display the Topic pane only. To display 
both panes of the window, click Navigation & Topic.

Notebook. Click to open the Notebook, where you can store a list of topics of particular 
interest, along with your own notes about them.

Glossary. Click to view an extensive glossary of terms and definitions related to Web site 
development.

Help. Click to get Help for Mastering Web Site Development.

Add to Notebook. Click to add the selected topic to your Notebook.

Delete. Click to delete the selected topic from your Notebook.

Print. Click to print topics or notes from your Notebook.

Paste. Click to paste selected topic text or contents of the Clipboard to your notes in the 
Notebook window.

Go to Topic. Select a topic in the Notebook, and then click to display the topic in the Topic 
pane.

You can also go to a topic by double-clicking the topic in the Notebook window.

URL launch. Automatically displays the Internet Address of the current site, or the site most recently accessed 
through Internet Explorer. You can enter a different URL in this text box and press ENTER to launch Internet 
Explorer to visit another site.



Contents. Click to view the Contents in the Navigation pane, and then click an entry to display a topic in the 
Topic pane.



Index. Click to view and search through the Index of the Course and Library.



Find. Click to search for a word or topic. You can type a word or phrase, or select a previous search string from 
the drop-down list. Mastering Web Site Development supports Boolean search operators.



Click to display Related Information, and then click a topic from the list to display it in the Topic pane.



Back. Click to go back through the topics you have viewed previously.

To see a list of all topics you have viewed during the current session, click History on the Navigate menu.



Previous. Click to move to the previous topic in the Navigation pane.



Next. Click to move to the next topic in the Navigation pane.



When you click the Contents button at the top of the Navigation pane, you can select a topic in the Course or 
Library, scroll through the topics, and click to view a topic in the Topic pane.

You can change from displaying the Contents in the Navigation pane to display the Index or Find window. To 
display the Index or Find window, click one of the Navigation buttons at the top of the Navigation pane.

Index. Displays index entries related 
to particular topics in the Course and 
the Library.

Find. Displays the Find window, 
where you can search for a word or 
topic.

When you click the Find button at the top of the Navigation pane, you can search for a word or phrase, or select 
a previous search string from the drop-down list. To search for a phrase, enclose the phrase in quotation marks.

Click a search result to display the text in the Topic pane.

You can switch the Navigation pane to display the Contents or Index by clicking one of these buttons at the top 
of the Navigation pane.

Contents. Displays topics for the 
Course or selections from the Library.

Index. Displays index entries related 
to particular topics in the Course and 
Library.

When you click the Index button at the top of the Navigation pane, you can click the text box and type the first 
few letters of a word. The Index will scroll to the closest entry, and list related topics in the list box at the bottom. 
Click an index entry to display the topic text in the Topic pane.

You can switch the Navigation pane to display Contents or the Find window by clicking one of these buttons at 
the top of the Navigation pane.

Contents. Displays topics for the 
Course or selections from the Library.

Find. Displays the Find window, 
where you can search for a word or 
topic.

The Topic pane always displays content, whether it is a selection from the Contents in the Navigation pane, a 
topic related to an index entry, or a topic you select from the results in the Find window. Click a topic in the 
Navigation pane to display it in the Topic pane.



Print Notebook dialog box. Click a selection to print the current Notebook topic or all topics stored in your 
Notebook. You can print your notes, topic text, or both.



Lists the Notebook entries, including those topics to which you have added notes. To display a Notebook entry 
in the Topic pane, double-click it, or select the topic and click the Go To button on the toolbar.

To add, edit, or delete notes for a particular topic, click the entry, and then add, revise, or delete the notes 
displayed in the Notes window.



Displays the Notes that you have created for particular topics. To add or revise your notes, click the Notes pane 
in the Notebook window.



Pop-up illustrations can be printed or copied to the Clipboard by using the appropriate command on the 
shortcut menu. Right-click the mouse, and then click Print or Copy.



The Sample Code window opens to the same size and location as when it was last closed. You can resize the 
window by dragging its borders.

You can select sample code to copy it to the Clipboard. Or, you can print or copy all of the sample code 
displayed in the window. Right-click the mouse to display the shortcut menu, and then click Print or Copy.



The Self-Check answer window opens to the same size and location as when it was last closed. You can 
resize the window by dragging its borders.

To view an answer, click the answer icon.

You can print or copy an answer to the Clipboard. Right-click the mouse to display the shortcut menu, and then 
click Print or Copy.

Note    You can print or copy the questions displayed in the Topic pane by clicking the Print button on the toolbar,
or by using the shortcut menu in the Topic pane.



The Tip window opens to the same size and location as when it was last closed. You can resize the window by 
dragging its borders.

You can select a portion of a tip to copy it to the Clipboard. Or, you can print or copy the entire tip. Right-click to 
display the shortcut menu, and then click Print or Copy.



The History window opens to the same size and location as when it was last closed. You can move it, or resize 
the window by dragging its borders.

Click a topic in the History window to display the topic text in the Topic pane.

Note    You must use the mouse to select a topic in the History window. The keyboard is disabled in this window.

The History window stays on top of the main Viewer window until you close it.



Increasing System Performance
If your computer meets minimum system requirements only, try the following procedures to increase system 
performance.

® Close all open applications when running the title.

u Have Windows 95 manage virtual memory settings
1. To display system properties in Windows 95, click here.

.
2. Click the Performance tab.
3. Click the Virtual Memory button, and then click Let Windows manage my virtual memory 

settings (recommended).

u Defragment your hard drive
1. Click the Windows 95 Start button, and then point to Programs.
2. Point to Accessories, point to System Tools, and then click Disk Defragmenter.

Note    To install the Disk Defragmenter, double-click the Add New Programs icon in the Control Panel.

u Optimize CD-ROM drive settings
1. To display system properties in Windows 95, click here.

.
2. Click the Performance tab.
3. Click the File System button, and then click the CD-ROM tab.
4. Increase the Supplemental cache size, and check that the settings and speed are correct in the 

Optimize access pattern for drop-down list box.

Related Topics



Audio Performance Problems
Mastering Web Site Development uses the following type of sound file:

® WAVE (*.wav): Digitized audio
To hear these sounds, you must have a sound card that is capable of playing WAVE sounds.

Your sound card uses a special piece of software called a "sound driver" to communicate with your computer. In 
some instances, you may not hear any sounds when using Mastering Web Site Development. Usually, this is 
because your sound driver is not installed or is configured improperly. If you do not hear any sounds, or get an 
error message saying that there is a problem with your sound card or sound driver when you start the program, 
the WAVE portion of your sound driver may be either improperly configured or not installed.

Related Topics



 I got an error message about my sound
The two most common error messages about WAVE sounds are:

® "A sound card is required to run Mastering Web Site Development."
® "Mastering Web Site Development cannot get the sound device right now, it's in use elsewhere, try again."

If you receive the first error message, it usually indicates that your sound driver is either not installed, not 
installed correctly, or not configured correctly. If you receive the second error message, it usually indicates that 
your sound driver is in use by another open program. Solve this by closing all other open programs, and 
restarting Mastering Web Site Development.

For more information about troubleshooting WAVE errors, see I can't hear any sounds.



I can't hear any sounds
u If sound does not play at all
1. Check the volume on your sound card or speakers, and if necessary, turn up the volume.
2. Check that the speakers are connected to your computer, that the power switch is on, and that the batteries (if

any) are functional.
3. Check that the software for the audio card is installed correctly, and if necessary, reinstall it.
4. Ensure that the audio card is pressed securely into its slot, or change a jumper setting on the audio card.
5. If you have both an audio card and special software that bypasses the audio card to play sounds through the 

PC speaker, try removing or disabling the PC speaker driver. This product requires MPC-compatible audio; it 
is not meant to run with the PC internal speaker only or any combination of the speaker and special software.



Checking Your Sound Card
u To ensure that your sound card is installed properly
1. To display system properties for Windows 95, click here.

.
2. Click the Device Manager tab, double-click Sound, video and game controllers, and then 

double-click the name of your sound card.
3. Click the General tab, and under Device status, check that the device is working properly.

Note    If your sound driver is not working properly, contact the manufacturer of your sound card.



My sounds are "scratchy"
Sound distortion is often caused by sending a higher volume or amplitude of sound than speakers are able to 
handle. If the volume control on your audio card is set too high, it may cause distortion from the amplifier on the 
audio card. Sometimes lower-quality speakers distort at a lower volume than higher-quality speakers.

For example, if your audio card or WAVE file output volume is set to near maximum, it will cause distortion. To 
change your audio card settings, refer to the documentation that came with your audio card.

u To adjust the volume control
1. To open volume control, click here.

.
2. Adjust the volume controls.
3. Click the Close box.



My sounds are cut off
Most audio cards can play only one sound at a time; therefore, other products with sound may interrupt sounds 
from this product. Some programs may take over the audio capability and prevent other Windows programs from
creating sounds.

If you think you have another program that produces sounds that could interrupt sounds from this product, do not
run the two programs simultaneously.



My sounds "skip"
If sound breaks up or "skips" periodically, it usually indicates that the CD-ROM drive does not meet the full MPC 
II (Multimedia PC - Level 2) specifications, and that it needs to be upgraded.

You can continue to use your CD-ROM drive to run this program, but sound will continue to skip.

u CD-ROM Drive requirements
® Double-speed CD-ROM: This CD-ROM drive can transfer data from the CD-ROM at 300 KB per second while

using less than 40% of the CPU bandwidth, and has an average seek time of less than 400 milliseconds.
® MS-DOS CD-ROM Extensions (MSCDEX) version 2.2 or later.



Checking and Changing Video Settings
Mastering Web Site Development requires that your video driver supports a screen resolution of at least 640 x 
480 (the program will support higher screen resolutions, but we recommend you use 800 x 600 or greater). In 
addition, the program requires that your video driver is able to display 256 colors.

u To check video settings or change them
1. To view display properties in Windows 95, click here.

.
2. Click the Settings tab.
3. Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine whether you can change your screen resolution.

If your video driver is not working properly, contact the manufacturer of your video card.

Related Topics



The display driver supports less than 256 
colors
Mastering Web Site Development requires a video driver that supports a screen resolution of at least 640 x 480, 
although the program will support higher screen resolutions. In addition, the program requires that the video 
driver be able to display 256 colors.

u To check video settings or change them:
1. To view display properties in Windows 95, click here.

.
2. Click the Settings tab.
3. Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine whether you can change your screen resolution.

If your video driver is not working properly, contact the manufacturer of your video card.



My machine "hangs"
If you use accelerated video drivers, video drivers with more than 256 colors, or high-resolution video drivers, 
the product may not display videos correctly. For example, you may see garbled images, or the product may 
stop running when you play a video.

If you encounter these problems, change to a standard video mode, such as a 640 x 480 resolution with 256 
colors.

u To check video settings or change them:
1. To view display properties in Windows 95, click here.

2. Click the Settings tab.
3. Under Desktop Area, drag the slider.

Note    Your monitor and display adapter determine whether you can change your screen resolution.



When You Have a Question
If you have a question about Mastering Web Site Development, first refer to this Help file, or read the CD-ROM 
jewelcase booklet. If you cannot find the answer, contact Microsoft Technical Support.

If you still have a question, Microsoft offers technical support and services ranging from no-cost and low-cost 
online information services (available 24 hours a day, 7 days a week) to annual support plans. A brief description
of these services is provided in the following sections. 

Note    The services and prices listed here are available in the United States and Canada only. Services and 
prices outside of these countries may vary.

For information about Microsoft subsidiary offices, see Product Support Worldwide.

Related Topics



Product Support Within the United States 
and Canada
In the United States, no-charge support from Microsoft support engineers is available via a toll call between 6:00
A.M. and 6:00 P.M. Pacific time, Monday through Friday, excluding holidays. Call (425) 635-7033.

In Canada, support engineers are available via a toll call between 8:00 A.M. and 8:00 P.M. Eastern time, Monday 
through Friday, excluding holidays. Call (905) 568-3503.

When you call, you should be at your computer and have the appropriate product documentation. Be prepared 
to give the following information.

® The version number of the Microsoft product you are using. 
® The type of hardware you are using. 
® The exact wording of any messages displayed on your screen. 
® A description of what happened, and what you were doing when the problem occurred. 
® A description of how you tried to solve the problem. 



Electronic Services
Information and Electronic Services
Microsoft provides easy access to the latest technical and support information for Microsoft products. You can 
access a variety of no-cost and low-cost and information services 24 hours a day, 365 days a year.

Internet services and the Microsoft Network (MSN)

Access the Microsoft Frequently Asked Questions, Software Library, Knowledge Base, customer-to-customer 
newsgroups, and other technical information and services on our Internet sites.

® On the World Wide Web and MSN, go to http://www.microsoft.com/support/
® For FTP access, go to ftp://ftp.microsoft.com

Microsoft FastTips
Call (800) 936-4100 on a touch-tone telephone. Receive automated answers to common technical problems, 
and access popular articles from the Microsoft Knowledge Base, all of which are delivered by a recording or by 
fax. 

After you reach FastTips, you can use the following keys on your touch-tone telephone.

® To advance to the next message, press *.
® To repeat the current message, press 7.
® To return to the beginning of FastTips, press #.

Microsoft Download Service
Access via modem, sample programs, device drivers, patches, software updates, and programming aides (1200,
2400, or 9600 baud, no parity, 8 data bits, 1 stop bit). In the United States, call (425) 936-6735. In Canada, call 
(905) 507-3022.



Standard Support
In the United States, unlimited no-charge support is available via a toll call between 6:00 A.M. and 6:00 P.M. 
Pacific time, Monday through Friday, excluding holidays. For technical support for Mastering Web Site 
Development, call (425) 635-7033.

In Canada, support engineers are available via a toll call between 8:00 A.M. and 8:00 P.M. Eastern time, Monday
through Friday, excluding holidays. Call (905) 568-3503. 

When you call, you should be at your computer and have the appropriate product documentation. Be prepared 
to give the following information.

® The version number of the Microsoft product you are using.
® The type of hardware you are using, including network hardware, if applicable.
® The operating system you are using.
® The exact wording of any messages displayed on your screen.
® A description of what happened, and what you were doing when the problem occurred.
® A description of how you tried to solve the problem.



Priority Support
Microsoft Technical Support offers priority telephone access to Microsoft support engineers 24 hours a day, 7 
days a week, except holidays. Support is available on a per-incident basis, and by annual subscriptions.

In the United States, call (800) 936-5700; $25.00 (U.S.) per incident, billed to your VISA, MasterCard, or 
American Express.

In the United States, call (900) 555-2000; $2.00 (U.S.) per minute, $25.00 (U.S.) maximum. Charges appear on 
your telephone bill. Not available in Canada.

In Canada, call (800) 668-7975; $30.00 per incident, billed to your VISA, MasterCard, or American Express.



Text Telephone
Microsoft text telephone (TT/TDD) services are available for the deaf or hard-of-hearing. In the United States, 
use a TT/TDD modem, and dial (425) 635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through 
Friday, excluding holidays. In Canada, use a TT/TDD modem, and dial (905) 568-9641 between 8:00 A.M. and 
8:00 P.M. Eastern time, Monday through Friday, excluding holidays.



Other Support Options
Microsoft TechNet
Microsoft TechNet is the front-line resource for fast, complete answers to technical questions on Microsoft 
systems and desktop products. Information available on TechNet ranges from crucial data on client-server and 
workgroup computing, systems platforms, and database products, to the latest on support for Microsoft Windows
and Macintosh applications. As a TechNet user you receive:

® Twelve monthly compact discs containing the Microsoft Knowledge Base, Microsoft operating systems 
product resource kits, customer solutions, key Microsoft conference session notes, and other valuable 
information.

® Twelve monthly supplemental compact discs (drivers and patches) containing the Microsoft Software Library.
® A dedicated Microsoft TechNet forum on CompuServe (type GO TECHNET).
® WinCIM, a Windows application for accessing CompuServe.
® A 20% discount on Microsoft Press books.

For more information about Microsoft TechNet, in the U.S. and Canada, call (800) 344-2121, between 7:00 A.M. 
and 7:00 P.M. Central time, Monday through Friday. Outside the U.S. and Canada, contact your Microsoft 
subsidiary, or call (303) 684-0914.

Microsoft Authorized Support Centers
Microsoft Authorized Support Centers (ACSs) are a select group of strategic support providers who offer high-
quality customized support services that span the complete systems life cycle of planning, implementation, and 
maintenance of your multi-vendor environment. Services include:

® On-site support
® Integration and implementation services
® Help desk services
® Hardware support
® Development resources

Choosing an ASC enables you to work with one vendor for all of your technical support and service needs. You 
can also combine ASC services with your in-house help desk, or the Microsoft support service option that best 
fits your information technology support needs.

For more information about the ASC program, in the U.S. call (800) 936-3500 between 6:00 A.M. and 6:00 P.M. 
Pacific time, Monday through Friday, excluding holidays. In Canada, call (800) 563-9048 between 8:00 A.M. and 
8:00 P.M. Eastern time, Monday through Friday, excluding holidays.



Product Training and Consultation
Microsoft Solution Providers are independent developers, consultants, and systems analysts who offer fee-
based technical training and support, industry knowledge, objective advice, and a range of value-added services
to companies of all sizes. Solution Providers work with organizations to help implement computing systems that 
take advantage of the current new technologies.

For the name of a Microsoft Solution Provider near you, in the U.S. call (800) 426-9400 between 6:30 A.M. and 
5:30 P.M. Pacific time, Monday through Friday, excluding holidays. In Canada, call (800) 563-9048 between 8:00
A.M. and 8:00 P.M. Eastern time, Monday through Friday, excluding holidays.



Product Support Worldwide
If you are outside the United States and have a question about a Microsoft product, first:

® Consult the documentation and other printed information included with your product.
® Check online Help.
® Consult electronic options, such as CompuServe forums or bulletin boards, if available.

If you cannot find a solution, you can receive information about how to obtain product support by contacting the 
Microsoft subsidiary office that serves your country.

Calling a Microsoft Subsidiary Office

When you call, you should be at your computer and have the appropriate product documentation. Be prepared 
to give the following information.

® The version number of the Microsoft product you are using.
® The type of hardware you are using, including network hardware, if applicable.
® The operating system you are using.
® The exact wording of any messages displayed on your screen.
® A description of what happened, and what you were doing when the problem occurred.
® A description of how you tried to solve the problem.

Microsoft subsidiary offices, and the countries they serve, are listed as follows. If there is no Microsoft office in 
your country, contact the establishment from which you purchased your Microsoft product.

Argentina
Australia
Austria
Europe
Belgium
Bolivia
Brazil
Canada
Caribbean
Czech Republic
Chile
Colombia
Denmark
Dubai
Equador
England
Finland
France
French Polynesia
Germany
Greece
Hong Kong
Hungary
Indonesia
India



Ireland
Israel
Italy
Japan
Korea
Liechtenstein
Luxembourg
Malaysia
México
Netherlands
New Zealand
Northern Ireland
Norway
Papua New Guinea
Paraguay
Philippines
Poland
Portugal
Republic of China
Republic of Ireland
Russia
Scotland
Singapore
Slovenia
Slovak Republic
South Africa
Spain
Sweden
Switzerland
Turkey
United Kingdom
Uruguay
Venezuela
Wales



Your computer uses hardware called a video card (or video display adapter) to display images on your video 
monitor. Your computer also uses software called a "video driver" to communicate with your video card (and vice
versa).



Video color depth refers to the number of colors that your video driver is capable of displaying simultaneously on
your monitor.    The maximum number of colors that you can display is determined by a combination of two 
factors: the amount of video RAM (or VRAM) that your video card has, and the screen resolution.

Most video cards can display 256 colors at a screen resolution of 640 x 480. Greater color depth, or greater 
screen resolution with 256 or more colors, may require additional VRAM.

Color depth is referred to in terms of "bits" (for example, 8-bit). The number of colors you see is equal to the 
number 2 to the power of the number of bits to which your color depth is set. The following is a list of the most 
common color depths and the number of colors that they represent:

2 bit 4 colors
4 bit 16 colors
8 bit 256 colors
16 bit 65,536 colors (often referred to as 64K or 64,000 

colors)
24 bit 16,777,216 colors (often referred to as 16M or 16 

million colors)

DPI = Dots per inch



Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 



Microsoft Pty. Ltd.
Installation Support: (61) (02) 870-2870
Fax: (61) (02) 805-0519
Bulletin Board Service: (61) (02) 878-5200
Technical Support: (61) (02) 870-2131
Sales Information Centre: (61) (02) 870-2100



Microsoft Ges.m.b.H.
Phone: 0222-68 7607
Fax: 0222-68 16 2710
Information: 0660-6520
Prices, updates, etc.: 0660-6520
Windows installation: 0660-6520
CompuServe: GO MSEURO (Microsoft Central Europe)
General Information about Microsoft Technical Support in Central Europe:
Fax: 0049/2622/167006



Technical support: 0660-6511



Microsoft Belgium
Phone: (32) (2) 730-3911
Fax: (32) (2) 726-9609
Technical Support:
    (32) (2) 513-3274 (Dutch speaking)
    (32) (2) 502-3432 (English speaking)
    (32) (2) 513-2268 (French speaking)
Bulletin Board:
      (32) (2) 726-8545
      (14400/1200/2400/9600 bd, 8N1, ANSI)



(Argentina)
Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 



Microsoft Informatica Ltda.
Phone: (55) (11) 514 -7100
Fax: (55) (11) 514 - 7106/514-7107
Technical Support Phone: (55) (11) 871-0090
Technical Support Fax: (55) (11) 262-8638
Technical Support Bulletin Board Service: (55) (11) 872-4106
Technical Support Help by Fax (55) (11) 871-4701 



Microsoft Canada, Inc.
Head Office Phone: (905) 568-0434
Customer Support Centre: (800) 563-9048
MS Office Technical Support Phone: 1 (905) 568-2294
Priority Support Information: 1 (800) 668-7975
Text Telephone (TT/TDD) 1 (905) 568-9641
Technical Support Bulletin Board Service: 1 (905) 507-3022 



Microsoft Caribbean, Inc
Tel: (809) 273-3600
Fax: (809) 273-3636
Technical Support: (214) 714-9100



Microsoft Chile S.A.
Phone: (56) (2) 330-6000
Fax: (56) (2) 330-6190
Customer Service: 56) (2) 800-213121
Personal Operating System and Applications:
Phone: (56) (2)-330-6222
Fax: (56) (2) 341-1439 



Microsoft Colombia
Tel: (571) 618 2245
Soporte Tecnico: (571) 618 2255
Fax:(571) 618 2269



Microsoft
Panská 6
11000 Praha 1
Phone (+42) (2) 2423-7089 or 2423-4325
Fax: (+42) (2) 2423-4343
Technical Support:
Phone: (+42) (2) 2150 3222



Microsoft Denmark AS
Phone: (45) (44) 89 01 00
Technical Support: (45)    (44) 89 01 11
Microsoft Sales Support: (45) (44) 89 01 90
Microsoft BBS:
      (45) (44) 66 90 46
      (Document 303030 in FaxSvar contains detailed instructions)
Microsoft FaxSvar: (45) (44) 89 01 44



Microsoft Middle East
Phone: (971) 4 513 888
Fax: (971) 4 527 444



Microsoft Corporation Equador S.A.
Phone: (593) 2 460-447, (593) 2 460-451
Customer Service: (593) 2 460-453, (593) 2 460-458
Technical Support: (593) (2) 463-094



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065 (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft OY
For Technical Support, please contact your local dealer.
Phone: (0358) (90) 525 502 500
Microsoft FaxSvar: (46) (0)8 752 29 00
      (Information in Swedish and English)
Microsoft BBS:
      (46) (0) 8 750 47 42
      (Information in Swedish and English)
Microsoft MSDL: 90-455 03 66
Microsoft FastTips: 90-525 502 550



Microsoft France
Phone: (33) (1) 69-86-46-46
Telex: MSPARIS 604322
Fax: (33) (1) 64-46-06-60
Technical Support Phone: (33) (1) 69-86-10-20
Technical Support Fax: (33) (1) 69-28-00-28
Fax Information Service: (33) 36-70-13-13



(France)
Microsoft France
Phone: (33) (1) 69-86-46-46
Telex: MSPARIS 604322
Fax: (33) (1) 64-46-06-60
Technical Support Phone: (33) (1) 69-86-10-20
Technical Support Fax: (33) (1) 69-28-00-28
Fax Information Service: (33) 36-70-13-13



Microsoft GmbH
Phone: 089-3176-0
Telex: (17) 89 83 28 MS GMBH D
Fax: 089-3176-1000
Information: 089-3176 1199
Prices, updates, etc.: 089-3176 1199
CompuServe: GO MSEURO (Microsoft Central Europe)
Bulletin board, device drivers, tech notes:
      Btx: *microsoft# or *610808000#
Standard Support: Installation and Handling
Windows 95: 089 / 31 76 - 11 15
General information about Microsoft Technical Support in Central Europe:
FAX: 02622/167006



Microsoft Hellas, S.A.
Phone: (30) 1 6806-775 through (30) 1 6806-779
Fax: (30) 1 6806 780



Microsoft Hong Kong Limited
Microsoft Hong Kong Limited Phone (852)-2804-4200
Microsoft Hong Kong Limited Fax (852)-2560-2217
Product Support Services (852)-2804-4222
PSS Faxback Service: (852)-2535-9293
Microsoft Club Upgrade Centre: (852)-2880-5085
Microsoft Club Member Hotline: (852)-2516-5113
Technical Support: (852)-2804-4222



Microsoft Kft.
Phone: (+36) (1) 268-1668
Fax: (+36) (1) 268-1558
Microsoft Hotline/Customer Service: (+36) (1) 2MS-INFO (267-4636)



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft India
Phone: (01) (91) 646 0694, 646 0767, 646 0813
Fax: (01) (91) 646-0813



Indonesia - Jakarta
Technical Support
Phone: (6221) 572-1060
Fax: (6221) 573-2077



Microsoft Israel Ltd.
Phone: 972-3-613-0833
Fax: 972-3-613-0834



Microsoft SpA
Phone: (39) (2) 7039-21
Fax: (39) (2) 7039-2020
Microsoft by Fax (Fax-on-demand service):
      (39) (2) 70-300-703
Customer Service (New product info, product literature):
      (39) (2) 70-398-398
Dealer Support (Customer Service for Dealers only):
      (39) (2) 70-398-388
Bulletin Board: (39) (2) 7030-0102
Technical Support: (39) (2) 70-398-351



Microsoft Company Ltd.
Phone: (81) (3) 5454-8000
Fax: (81) (3) 5454-7972
PSS Technical Support Fax: (81) (3) 5454-7955
Customer Service Phone (Version Upgrade/Registration)
Phone: (81) (3) 5454-2305
Fax: (81) (3) 5454-7952
Channel Marketing (Pre-sales Product Support) Information Center
Phone: (81) (3) 5454-2300
Fax: (81) (3) 5454-7951



Microsoft CH
Phone: (82) (2) 531-4500
Fax: (82) (2) 555-1724
Technical Support: (82) (2) 531-4800
Windows Tech Support Line: (82) (2) 563-0054
Technical Support Fax: (82) (2) 531-4600
Technical Support Bulletin Board Service: (82) (2) 538-3256



(German speaking Switzerland)
Microsoft AG
Phone: 01-839 61 11
Fax: 01-831 08 69
Prices, Updates: 01-839 61 11
Documentation: Phone: 155 59 00
Fax: 064-224294,
Microsoft Info-Service
Postfach, 8099 Zürich
Windows, Windows for Workgroups, Printing System: 01/342-4085
General information about Microsoft Technical Support in Central Europe:
FAX: 0049/2622/167006



Microsoft Luxemborg
Phone: +32 2 730 39 11
Fax: +32 2 726 96 09
CompuServe: (32) 2-2150530 (GO MSBEN)
Technical Support:
+32 2 513 32 74 (Dutch speaking)
+32 2 502 34 32 (English speaking)
+32 2 513 22 68 (French speaking)
Bulletin Board:
      +32 2 726 85 45
      (14400/1200/2400/9600 bd, 8N1, ANSI)



Microsoft (Malaysia) Sdn Bhd:
Phone: (60-3) 794-9595
Fax : (60-3) 791-6080



Microsoft México, S.A. de C.V.
Phone: (52) (5) 325-0910
Fax: (52) (5) 280-7940
Customer Service: (52) (5) 325-0911
Technical Support: (52) (5) 325-0912 Standard Support
Technical Support: (52)(5) 237-4800 Developers Tools and Advanced Systems
Fast Tips: (52)(5) 237-4894 (24 hours x 365 days service)
Bulletin Board Service:
      (52) (5) 628-6200
      (2400s/14400k baud, 8 bits, No parity, 1 stop bit, ANSI terminal emulation)
      (52) (5) 628-6202
      (14400k baud, 8 bits, No parity, 1 stop bit, ANSI terminal emulation)
      User: MSMEXICO, NO Password



Microsoft BV
Phone: 023-5689189
Customer Service: 023-5677700
CompuServe: 020-6880085 (GO MSBEN)
Technical Support:
023-5677877 (Dutch speaking)
023-5677853 (English speaking) 
Bulletin Board:
      023-5634221
      (1200/2400/9600 bd, 8N1, ANSI)



Microsoft New Zealand Ltd.
Phone: 64 (9) 358-3724
Fax: 64 (9) 358-3726
Technology Link Centre (Technical Support):
Phone: 64 (9) 357-5575
Fax: 64 (9) 307-0516 and 357-5577 



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft Norway AS
Phone: (47) (22) 02 25 00
Microsoft Sales Support: (47) (22) 02 25 80
Microsoft BBS:
      (47) 22 18 22 09
      (Document 404040 in FaxSvar contains detailed instructions)
Microsoft FaxSvar: (47) (22) 02 25 70
Technical Support: (47) (22) 02 25 50
Microsoft MSDL: 22 18 22 09
Microsoft FastTips: 22 02 25 70



(Australia)
Microsoft Pty. Ltd.
Installation Support: (61) (02) 870-2870
Fax: (61) (02) 805-0519
Bulletin Board Service: (61) (02) 878-5200
Technical Support: (61) (02) 870-2131
Sales Information Centre: (61) (02) 870-2100



(Argentina)
Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 



Microsoft Philippines
Phone: (632) 811-0062
Technical Support:
Phone : (632) 892-2295/2495
Fax: (632) 813-2493



Microsoft Sp.z o.o.
ul. Grzybowska 80/82
00-844 Warszawa
Phone: (+48) (22) 661-5405
Fax: (+48) (22) 661-5434
Technical Support:
Phone: (+48) (22) 621-6793 or (+48) (71) 441-357



MSFT, Lda.
MSFT, Lda.Phone: (351) (1) 440-9200
Fax: (351) (1) 441-2101
Technical Support:
Standard Support (All Clusters): (351) (1) 440-9280/1/2/3
Fax : (351) (1) 441-1655



Microsoft Taiwan Corp.
Phone: (886) (2) 504-3122
Fax: (886) (2) 504-3121
Technical Support : (886) (2) 508-9501



Microsoft A/O
Leningradsky Prospekt80
125178 Moscow
Phone: (+7) (502) 224 50 46
Fax: (+7) (502) 224 50 45



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service: 
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



Microsoft Singapore Pte Ltd
Phone: (65) 337-6088
Fax : (65) 337-6788
Customer Services Phone: (65) 433-5488
Customer Services Fax: (65) 339-9958
Product Support Phone: (65) 337-9946
Product Support Fax: (65) 337-6700



Microsoft d.o.o.
Technical Support
Phone: (+386) (61) 1881 133
Fax: (+386) (61) 1881 137
Technical Support: (+386) 61 123 23 54 or (+386) 64 331 020



Microsoft
Panská 6/ I
11000 Praha 1
Phone (+42) (2) 2423 7089 or 2423 4325
Fax: (+42) (2) 2423 4343
Technical Support:
Phone: (+42) (7) 312083



Microsoft South Africa
Phone: (27) 11 445 0000
Fax: (27) 11 445 0045 or (27) 11 445 0046
Technical Support (Toll Free): 0 802 11 11 04
(Toll): (2) 11 445 0100
Customer Service Centre: (27) 11 445 0145



Microsoft Iberica SRL
Phone: (34) (1) 807 99 99
Fax: (34) (1) 803 8310
Technical Support: 91 807 99 60
Customer Service: (34) (1) 804 0096
Fax Back telephone: 91 804 00 96



Microsoft AB
Phone: (46) (08) 752 09 29
Sales Support: (46) (8) 752 56 30
Microsoft FaxSvar: (46) (0)8 752 29 00
Microsoft BBS:
      (46) (8) 750 47 42
      (Document 202020 in FaxSvar contains detailed instructions)
Information on Technical Support: (46) (8) 752 09 29
Microsoft MSDL: 08-750 47 42
Microsoft FastTips: 08-752 29 00



Microsoft AG
Phone: (01) 839-6111
Fax: (01) 831-0869
Prices, updates, etc.: (01) 839-6111
CompuServe: GO MSEURO(Microsoft Central Europe)
Documentation:
Phone: 155-5900
Fax: (064) 224-294,
Microsoft Info-Service, Postfach, 8099 Zürich
Windows, Windows for Workgroups, Printing System: (01) 342-4085
Technical support (French speaking): (022) 738-9688
General information about Microsoft Technical Support in Central Europe:
FAX: (0049) (2622) 167-006



Microsoft Turkey
Phone: (90) 212 258-5998
Fax: (90) 212 258-5954



Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007 



(Argentina)
Microsoft de Argentina S.A.
Customer Service: (54) (1) 819-1900
Fax: (54) (1) 819-1921
Technical Support for Development Tools: (54) (1) 819-1900
Technical Support for Windows 95: (54) (1) 314-0560 

(Uruguay)
Technical Support: (598) (2) 77-4934 



Corporation MS 90 de Venezuela S.A.
General Information:
    (582)-993-6156
    (582)-91-4739
    (582)-91-3342
Fax: (582)-92-3835
Technical Support:
    (582)-993-5249
    (582)-993-9256 



(United Kingdom)
Microsoft Limited
Phone: (44) (01734) 27-0000, (01734) 27-0001
Fax: (01734) 27-0002
Pre-Sales Information: (0345) 00-2000
Upgrades & Registration: (44) (816) 14-8000
Bulletin Board Service:
      (01734) 27-0065
      (up to 14.4Kbaud, n, 8, 1)
Fax Information Service (01734) 27-0080
Customer Support: (01734) 27-1000
Developer Support: (01734) 27-1414
Advanced Systems Support: (01734) 27-1007



Top Support Issues in Interactive Media 
Applications
The following sections describe problems some customers have had with Interactive Media products, along with 
possible solutions.

Interactive Media products, ranging from children's products to reference and geography titles, are split into 
three multimedia areas:

® CD-ROM
® Sound
® Video Playback

This table shows the current top issues for each of the areas based on the frequency of each support issue 
since the beginning of 1996. Three of the nine issues listed in the table are described in detail in the following 
sections (each one indicated by an asterisk).



Issue 1:    CD-ROM Capacity Limit Exceeded
Description
Not all CD-ROM drives can access all the data a CD-ROM can hold, so attempts to access files outside the 
readable area will result in errors. To read the entire CD-ROM, the customer either has to get the product on a 
non-CD-ROM medium (if available) or upgrade his or her system to a CD-ROM drive with sufficient capacity. In 
some cases, it is only necessary to upgrade the firmware of the CD-ROM.

Calls on this topic can be long because the problem can be caused by many factors and because this issue 
cannot be resolved in real time for the customer. The average length of a support phone call for this problem is 
more than 33 minutes.

The constantly changing hardware industry and the fact that many customers have no idea what CD-ROM drive 
they have can also make finding the source of the problem difficult. Even leading upgrade kits can use a variety 
of different vendors for the CD-ROM drive, although packaging may be the same. 

See the Knowledge Base (article # Q141329) for more information about this issue.

Support Recommendation
Either don't create CD-ROM products that exceed the read capability of older CD-ROM drives or, if you 
absolutely must squeeze the last possible bit of data onto a CD-ROM, put those nonessential or infrequently 
used files in the areas that might not be readable by all CD-ROM drives.

Provide support groups with the physical location of files on the CD-ROM to help them troubleshoot errors 
reading files. If the support engineer knows that the problem file is well within the area that all CD-ROM drives 
can read, he or she can eliminate CD-ROM capacity as the problem and troubleshoot the problem more 
efficiently.



Issue 2:    CD-ROM Cache Setting Wrong 
(WIN 95)
Description
Incorrect cache settings for the CD-ROM drive hurt the performance of the drive (jumpy audio/video, read 
errors). Windows 95 might not be able to determine the correct cache setting during detection of the CD-ROM 
device. Generally, the support engineer will recommend that the supplemental cache size be set as large as 
possible. This advice is starting to appear in product README files, such as those for Bookshelf for Windows.

See the Knowledge Base (article # Q141368) for more information and for recommendations on how to specify 
the appropriate cache size for different media types.

Support Recommendation
Windows needs to do a better job of choosing the appropriate cache settings for CD-ROM drives, but until then, 
products that rely on a minimum level of CD-ROM performance need to recognize when that performance is not 
being delivered and help customers troubleshoot the problem. One way to help is to ship the Multimedia 
Troubleshooter (part of MSInfo 2.5) with your product.



Issue 3:    CD Audio MCI Driver(s) Not 
Installed
Description
The product cannot play CD Audio sound because the necessary drivers are not installed. For example, the 
Windows 95 typical installation does not install the CD Audio (CD Player) capability under some circumstances, 
such as if it was installed from floppy disks or the CD-ROM was not detected correctly during network 
installation. 

Because of the unambiguous error message and straightforward solutions, the average length of support calls is
only 12 minutes.

Depending on how the support engineer judges the capabilities of the customer, the engineer will either walk the 
customer through the actual driver installation or simply provide the customer with instructions.

Potentially complicating the problem is the chance that a customer does not have ready access to a Windows 95
CD-ROM that contains the necessary files, either because he or she purchased Windows 95 on floppy disk or 
because Windows 95 was preinstalled and the OEM did not provide disks. 

We recently put the CD Audio drivers on MSDL (Microsoft Download) so that customers who fall into this group 
and have a modem can download the drivers and instructions. If a customer does not have a modem, he or she 
can contact the OEM or can call Windows support for additional assistance.

See the Knowledge Base (article # 139659) for more information about this issue.

Support Recommendation
In the short term, products that depend on a technology or driver should, at the very least, verify that the 
necessary driver and/or technology is installed. If not, a useful error message should be provided to help the 
users resolve the issue.

For the long term, we recommend that products recognize when a critical component is missing and actually 
walk the customer through the installation. For instance, a CD-ROM product requiring CD Audio support would 
actually alert the customer and launch an "intelligent" Windows setup program to install the component.



Support Maxim
The anonymous quote, "Every time history repeats itself the price tag goes up," illustrates the reason for this 
month's maxim:

Avoid Even/Odd (Flip/Flop) issues.

Description
When a product group decides to change a feature to eliminate support issues, it should understand why the 
feature was originally implemented. Doing so avoids accidentally swapping one set of problems for another 
between alternate releases.

The issue "CD Audio MCI Driver(s) Not Installed" shows how this maxim could be applied to prevent flip-flopping
of issues between subsequent releases.

With a high frequency of support, CD Audio might not seem like the way to go about delivering audio on future 
CD-ROM products. But CD Audio was chosen over WAV audio or MIDI because WAV and MIDI audio also have 
a large number of support issues and are difficult for customers and support engineers to troubleshoot. 

By comparison, the CD Audio issue is much easier to resolve. A strong case can be made for releasing more 
products using CD Audio as the primary source of sound and improving the product error messages and 
troubleshooting assistance. Taking this route could make it easy for customers to resolve the issue without 
calling AnswerPoint support. 

For More Information
For more information, visit these web sites.

® AnswerPoint:    http://www.microsoft.com/supportnet/AnswerPoint/
® Support Online:    http://www.microsoft.com/support/
® Knowledge Base:    http://www.microsoft.com/kb




